Link Plus Beta Version 3
Software Download, Installation, and 

Enhancements Description and Instructions
Introduction
Thank you for using the beta version of Link Plus version 3.0. Link Plus production version 3.0 will be a major release, as we have added several new functions and enhancements. Unfortunately due to a temporary lack of resources, there is currently no projected release date for the production version of Link Plus 3.0. As a result CDC is releasing the beta version of the software on an as requested basis until we can release the production version. 
We would greatly appreciate receiving feedback from you during your use of the beta version of the software. In particular, if you happen to experience a run time error, please report the error to us immediately, so that the identified problem can be addressed as soon as possible. 

If you are a new Link Plus user, or do not know how to perform a certain task, please refer to the online help provided within the software.  You can open the help by clicking on the [image: image1.bmp] icon on the toolbar, or on any of the various forms presented throughout the linkage process.  As the context sensitive and Online Help provided within the v3.0 beta software has not yet been updated to reflect the new features of the software, we have generated this document describing the new features and providing instructions on using them.  If you run into a situation where you would like to use a feature for which you cannot find Help and that is not described in this document, please contact us and we will guide you through the steps necessary to complete the task.  

Overview of Link Plus

Link Plus is a probabilistic record linkage program developed by the U.S. Centers for Disease Control and Prevention (CDC), Cancer Division.  Link Plus was written as a linkage tool for cancer registries, in support of CDC's National Program of Cancer Registries.  It is an easy-to-use, stand-alone, Windows application that can be run in two modes: to detect duplicates in a cancer registry database, or to link a cancer registry file against external files. Once a linkage has been run, Link Plus provides powerful support for the manual review of uncertain matches, and offers the option of a merged export file upon completion of review. Although Link Plus was originally designed for use with cancer registry data, the program has been used extensively across a diversity of research disciplines, as there is no theoretical or practical barrier to using the program with data other than cancer registry data.

In 2004, CDC released the 1st production version of Link Plus, Version 1.0, which probabilistically linked files and allowed 1-1 matching, but provided no support for manual review of comparison pairs.  The 2nd production version of Link Plus, Version 2.0, was released in 2007 and allowed 1-1 matching and included powerful support for the manual review process.  The Link Plus beta version 3.0 includes many enhancements throughout the program:

External Data Linkage

· Removes the limitation on the number of records included in File 2; the program works for any number of records in File 2 as long as the computer has sufficient memory to read in data from File 1 (estimated limitation of 4.5-4.8 million records for the file size of File 1)
· Users can choose whether to write all potential matches (many-to-many linkages) or only the matches with the highest score to the linkage report (1-to-many linkages)

· Provides confirmation-like matching method for variables such as address where an exact match contributes a positive weight to the total linkage score while no match contributes nothing (zero weight) to the total score
· Provides SSN-like matching method for a generic ID which allows partial matching by calculating similarity 

· Provides refined name matching methods that are more robust against the frequency of names or outlier of names, and can handle the names with embedded spaces and apply partial matching algorithms to swapped names
· Allows the user to specify whether or not a non-match report is generated

· Can handle the 22824 LRECL of the NAACCR v12.x record layout and includes default NAACCR version 12.x record layout
Manual Review

· Users can use “Assign Set ID” to group matches into mutually exclusive match sets by person

· Removes the limitation of the maximum size of 30,000 pairs on the manual review window; the new maximum is 300,000 pairs

Export of Linkage Results
As with Link Plus version 2.0, when manual review is complete, Link Plus version 3.0 beta allows for the export of a merged file. In addition, either version of Link Plus can export records based on match status, allowing you to export true matches only, or false matches only, or all. However, the Link Plus version 3.0 beta software offers 3 export options:

· Export of delimited files (works the same way as in Link Plus version 2.0)

· Users can now export the results of manual review to any fixed width file format, including NAACCR-formatted files
· Export all non-matches export option.

Download and Installation

To install Link Plus, please complete the following steps:

1) Click on the below ftp link, which will direct you to our ftp site:  ftp://ftp.cdc.gov/pub/Software/RegistryPlus/Link_Plus/ 
2) Download the program the program named linkplusbeta3_0-1-18-2012.exe to your computer. 
3) Once the installation file is downloaded:

a) If you already have prior version of Link Plus on your computer, you will need to uninstall this version prior to installing the beta version.

i) Click Start(All Programs(Registry Plus(Link Plus(Uninstall Link Plus.

ii) Click Yes, you are sure you would like to uninstall this product, and Link Plus will be uninstalled.  This may take a couple of minutes.  Once the previous version of Link Plus is uninstalled, continue to the next step to install the v3.0 beta program.

b) To install the v3.0 beta program, double-click on the LinkPlus3.0.exe file. This will launch the installation program wizard, and which will take you through the steps to install the Link Plus v3.0 beta program. 
i) If you are a first-time user of Link Plus, it is recommended that you accept the suggested defaults while installing Link Plus.
Launching Link Plus
To launch the Link Plus beta program, Click Start(All Programs(Registry Plus(Link Plus(Link Plus.
Link Plus Demonstration Linkages
For new Link Plus users and those who would like to immediately see the program’s new features, the Link Plus installation includes test data files and configuration files for demonstration purposes. To run the demonstrations, go to the File menu and select Open Configuration File.  From the configuration folder displayed, select the file FWDemo.cfg to perform linkage on two fixed width demonstration files, or DelimDemo.cfg to perform linkage on two delimited demonstration files. You can experiment with additional features of the program by making changes on the configuration form and saving your new configurations under different file names.  The linkage report that is generated from any of the demonstrations can be also opened for manual review, so you can quickly see all of the new features added to the program that support the manual review of comparison pairs and export of merged files. 
Steps Required for External Linkage with v3.0 Beta
1. Select Data Type for File 1

2. Locate/Identify File 1

3. Data Import for File 1

4. Select Data Type for File 2

5. Locate/Identify File 2

6. Data Import for File 2

7. Select Blocking Variables & Phonetic System

8. Select Matching Variables & Matching Methods

9. Select ID Variables

10. Select Data Type for File 1

11. Locate/Identify File 1

12. Data Import for File 1

13. Select Data Type for File 2

14. Locate/Identify File 2

15. Data Import for File 2

16. Select Blocking Variables & Phonetic System

17. Select Matching Variables & Matching Methods

18. Select ID Variables

Steps Required for Deduplication Linkages

The required steps for Deduplication Linkages are the same as those for External Linkages, except that you are only working with a single data file, the many-many matching feature is not available for deduplication linkages (by default all comparison pairs generating a linkage score equal to or above the specified Cutoff value are written to the linkage report), and no Non-match report is generated.
Description and Use Instructions for Select Enhancements

Best Match Option: 1-1 or Many-Many Linkage
Link Plus v3.0 has the option to run many to many matching in addition to the already available option of running 1 to many linkages. This new many to many matching option is available for external linkages only and can be used by un-checking the "Best match" check box on the linkage configuration window:

[image: image2.png]~ Best match




When the Best Match check box is checked, Link Plus will save only the comparison pair with the highest agreement weight, or linkage score, to the linkage report and present it for manual review. Subsequent records are only compared with available remaining records that have not been assigned. When the Best Match check box is un-checked, enabling many to many matching, all potential matches will be written to the linkage report and presented for manual review.

The new many-to-many matching feature should be used with caution as it will list all comparison pairs with score >= the cutoff value in the linkage report and present them for manual review.  As a result, many false matches will be included for manual review, and the manual review process will consume considerably more time.

Optional Generation of Non-Match Report

Upon the running of a linkage, Link Plus version 2.0 automatically generated a non-match report, named Non_MatchReport.txt, which contains records from File 2 not matched to records in File 1 (records receiving a linkage score below the specified Cutoff Value). As it may not always be needed, and may contain confidential information, Link Plus version 3.0 provides the user with the option to generate the non-match report upon request only.  This new option may be used by clicking or un-clicking the Produce non-match report box on the linkage configuration window:

[image: image3.png]™ Produce non-match report




When the Produce non-match report box is clicked, Link Plus will generate the non-match report; when the box is un-clicked, no non-match report is generated.
Delimited File Export

When your manual review is complete, Link Plus allows for the export of a merged file in Delimited file format, where the user builds the export file, specifying what fields from each file to export.
When exporting your linkage results in delimited file format, Link Plus allows you to specify what file delimiter you would like to use, and what match status(es) you would like to export.
To set the export file format option and export a merged file in delimited file format, complete these steps:

1. Click on the Tools menu item, and select Options…
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Result:  The Options dialog box opens, with the Manual Review tab selected.
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2. Click on the Export tab.
Result:  The Export Options dialog box opens.
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3. Specify the file delimiter by clicking on the Tab, Comma, or Semi Colon radio buttons, or click Other and to enter another file delimiter. In the example shown the delimiter is being set to Comma.
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4. Specify the match status(es) that you would like included in your output file, and then click OK. In the example shown only false matches are being specified for export.
Result:  The delimited export file format has now been set to the delimiter of your choice, and when the data are exported, only records assigned the specified match status will be exported.

5. To export the delimited merged file, click on the Data menu item, and click on Export Delimited File…
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Result:  The Export Delimited File dialog box opens.
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6. Select the fields from File 1 and File 2 that you would like in your merged export file by clicking the box in the column to the left of the data field.  Click the fields in the order in which you would like them listed in the export file.

7. To specify the location and file name of the merged export file, click the folder icon to right of the Export merged records to box.
Result:  A window opens where you can specify a name for the exported merged file, and location on your PC or on a shared network folder where you would like to save the file. The default location for exported files within Link Plus is the C:/RegPlus/LinkPlus/Export folder.
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8. In the File name box, enter the name of the file, and click Save. In the example shown the delimited export file is named External1.txt.
Result: You are returned to the Export Delimited File dialog box, where the file name and path of the export file are now displayed.
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9. Click Export.

Result:  A delimited file merged file with the specified delimiter and file name and path, including records with the specified match status(es), and with the data fields you selected (in the order you selected them) is generated and placed in the C:/RegPlus/LinkPlus/Export folder.  In addition, Notepad will open with a view of the merged file.
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	If you are having trouble viewing the information in this file, you can adjust the font size and turn off the Word Wrap option under the Format menu in Notepad.

This file can be easily imported into Microsoft Excel.


10. Close out of Notepad and click Close on the Export Delimited File dialog box to return to the manual review screen.

Exporting a Fixed Width Merged File

To export your linkage results in fixed width file format, as with the delimited export file, Link Plus allows you to specify what match status(es) you would like to export.

When users choose a fixed width file export, there are 4 options to choose from:
1. Exporting all of the records in File 1. 
2. Exporting all of the records in File 2.
3. Exporting all records from File 1 and replace the fields selected from a pull-down list for File 1 with the corresponding fields selected from the pull-down list for File 2.
4. Exporting all records from File 2 and replace the fields selected from a pull-down list for File 2 with the corresponding fields selected from a pull-down list for File 1.
The Fixed width export options work for any fixed width files, including files in the NAACCR fixed width record layout. It also works for two fixed width files with different record layouts.  The record layouts are only used for reading in the selected variables.  For instance, if you want to export File 1 with replaced last name from File 2 for all matched cases, then the program will extract the last name from File 2 and replace the last name of File 1 starting from the start position of last name in File 1. If the length of last name in File 2 is greater the length of the last name in File 1, the program will truncate the last name from File 2 to the same length of the last name in File 1. If the length of last name from File 2 is shorter than the one from File 1, the program will pad the last name field from File 2 with spaces so that the two last names have the same length.

To export the merged file in fixed width format, complete these steps:

1. Click on the Data menu item, and click on Export Fixed Width File…
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Result:  The Export Fixed Width File dialog box opens.
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Note that if the base File that you select to export is in NAACCR file format then you will be exporting records in the NAACCR file format.

2. Select the export option of your choice.  In the example being shown, the Export records in File 1 replaced with specified variables in File 2 option is selected.

3. Click on the first empty cell of the grid in Field Name (File 1) column. 
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Result:  A drop-down menu appears. When the down arrow is clicked, this menu contains all of the variable names of the variables that were specified for the record layout for File 1.
4. Using the drop-down menus for File 1 and File 2, specify any fields you would like to overwrite on the file being exported.  For every data field that you would like to overwrite you must make a selection from both the File 1 and File 2 drop-down menus.  In the example shown, merged records in File 1 are being exported and the Date of Last Contact field in File 1 is being replaced with the Date of Death field from File 2.
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5. To specify the location and file name of the merged export file, click the folder icon to right of the Export results to box.
Result:  A window opens where you can specify a name for the exported fixed width merged file, and location on your PC or on a shared network folder where you would like to save the file. The default location for exported files within Link Plus is the C:/RegPlus/LinkPlus/Export folder.

[image: image18.png]Xl

() [~ regpes ~ ket - Bert o= ©
Organize v [Zviews | NewFolder @
Favorte ks Name_~ |+ pate modied |+ Type (R
[ BCCEDP Matches 2011220.0¢ /18702 3:53AM TXTFe
[} ocuments | 1BCCEDP_Non_Matches_20111220.6x¢ 1/18/20124:37AM TXTFile
More » | etemalt.o S/31/20127:37PM T Fie
| testFexportxt 5/25/2012 10:10... TXTFie
Folders v testiMxt 1/29/20126:33PM  TXT File
i eomse (4]
L editirter
i GeneDITSp
U wies
1. Confiurs:
0l dete
LT |
File name: [External2. bt =
Save o type: [Tertris =

e s e





6. In the File name box, enter the file name you would like for your fixed width export file, and click Save. In the example shown, the file is being named External2.txt.
Result: You are returned to the Export Fixed Width File dialog box, where the file name and path of the export file are now displayed.
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7. Click Export.
Result: The application lets you know that the file has been successfully exported.
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8. Click OK.
Result: You are returned to the Export Fixed Width File dialog box.
9. Click Close to return to the manual review screen.

Exporting All Non-matches to a Single Export File

Upon linkage, Link Plus version 2.0 automatically generated a Non-Match file upon linkage that included all of the all records from File 2 that generated a linkage score lower than the Cutoff Value specified for the linkage on the Linkage Configuration window.  Then during the manual review process of potential comparison pairs, more records may be assigned a false match status.  It was up to the user to bring the non-matches from the Non-match file and from manual review together outside of Link Plus.

The Link Plus v3.0 beta software has a new option to export all non-matches is a single convenient file, called the Export All Non-matches export option.  This export file will include all records from File 2 that generated a linkage score lower than the Cutoff Value specified for the linkage on the Linkage Configuration window, as well as any records that have been assigned a false match status upon review of potential matches presented for review on the Manual Review window. 

The All Non-matches export file will be exported in the same file format as File 2. If File 2 is a delimited file, the All Non-matches export file will be exported with the same delimiter, fields, and field order as File 2.  If File 2 is a fixed width file, the All-Non-matches export file will be exported with the same fields and record layout as File 2. 

Note that if the File 2 is in NAACCR file format then you will be exporting records in the NAACCR file format.
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	When using this export option, use of the Generate Non-match Report option on the Linkage Configuration window is not needed.


1. To export all non-matches to a single export file in File 2 format, click on the Data menu item, and select Export All Non-matches of File 2…
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Result:  The Export All Non-matches dialog box opens.
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2. To specify the location and file name of the non-match file, click the folder icon to right of the Export all non-matches box.

Result:  A window opens where you can specify a name for the exported non-match file, and location on your PC or on a shared network folder where you would like to save the file. The default location for exported files within Link Plus is the C:/RegPlus/LinkPlus/Export folder.
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3. In the File name box, enter the file name you would like for your All Non-matches export file, and click Save. In the example shown, the file is being named External3.txt.

Result: You are returned to the Export All Non-matches dialog box, where the file name and path of the export file are now displayed.
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4. Click Export.

Result: The application lets you know that the file has been successfully exported.
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5. Click OK.

Result: You are returned to the Export All Non-matches dialog box.

6. Click Close to return to the manual review screen.

Known Issues with Link Plus v3.0 Beta Program

The Link Plus v3.0 beta program has the following known issues at this time:

Linkage configurations generated using the Link Plus v2.0 production program will not work in the v3.0 beta program.  You will need to re-create any historical linkage configurations when using the v3.0 beta software.

While performing manual review, you cannot use the up and down arrow keys or page up and page down arrow keys to navigate through comparison pairs displayed on the manual review window.  You must use your mouse and scroll using the vertical scroll bar.

If while using the program you experience any issues using the program, please contact us immediately with a description of the issue, in particular if you experience a runtime error.  Screen shots sent along with the description of the identified issue are greatly appreciated, as they facilitate issue resolution.

Contact Information
To report runtime errors or other technical problems, or to obtain help configuring linkages or performing certain tasks, please contact:

Scott Van Heest

Cancer Surveillance Branch

Division of Cancer Prevention and Control 

National Center for Chronic Disease Prevention and Health Promotion

Centers for Disease Control and Prevention 

Telephone: 770-488-4863
Facsimile: 770-488-4759

E-mail: svanheest@cdc.gov
For general questions, please contact:
Joseph D. Rogers (Joe)

Chief, Data Analysis and Support Activity

Cancer Surveillance Branch

Division of Cancer Prevention and Control 

National Center for Chronic Disease Prevention and Health Promotion

Centers for Disease Control and Prevention 

Telephone: 770-488-4701

Facsimile: 770-488-4759

E-mail: JRogers@cdc.gov
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